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APRESENTAÇÃO

O AutoCAD 2016 é um software proprietário da Autodesk.  A Autodesk vem

desenvolvendo  o  software  AutoCAD desde  1982.  Ao  longo  de  mais  de  30  anos  o

programa evoluiu muito, incorporando correções sugeridas por profissionais de todo o

mundo. 
Na atualidade há diversos outros softwares semelhantes e mais específicos para

desenho de móveis,  para desenho mecânico entre outros.  Mas o AutoCAD continua

sendo ainda um dos softwares mais utilizados na área de projetos em todo mundo. 
Aprendemos  a  utilizar  o  AutoCAD na  década  de  1990 e  desde  então  temos

acompanhado  a  evolução  das  diversas  versões  do  programa  e  elaborado  apostilas

didáticas para o ensino da disciplina para os estudantes do IFSC. 
Com o tempo desenvolvemos um método para ensinar  o uso do programa a

partir  de  apenas  10  comandos  mais  importantes.  O  AutoCAD  tem  centenas  de

comandos em sua  estrutura,  mas  eles  não  precisam ser  aprendidos  pelos  iniciantes.

Quando os alunos aprendem os 10 comandos mais importantes, ganham segurança para

explorar outros. Esse método tem sido bem sucedido há mais de uma década e será

apresentado nesse livro.
Nos próximos capítulos, os estudantes vão aprender como baixar a  versão de

estudante do AutoCAD 2016 e como elaborar desenhos simples, passo a passo. Esses

passos, além de mostrados em figuras também são mostrados em videoaulas produzidas

exclusivamente para esse livro. Acessem os vídeos nos endereços: 

https://www.youtube.com/watch?v=HuH7MgEap6s  (Configuração inicial)

https://www.youtube.com/watch?v=6AqXMA0IOIM  (Exemplo - peça 1)

https://www.youtube.com/watch?v=uL2UyP2bas8  (Exemplo - peça 2)

https://youtu.be/wqlh1fpZEzM (Exemplo - planta baixa)

Esperamos contribuir para que os desenhistas iniciantes possam aprender essa

importante  ferramenta,  utilizada  no mundo todo por  profissionais  das  mais  diversas

áreas. 
André  Coelho  da  Silva   -  Professor  do  Instituto  Federal  de  Educação,  Ciência  e

Tecnologia
Jesué  Graciliano  da  Silva  -  Professor  do  Instituto  Federal  de  Educação,  Ciência  e

Tecnologia
Gilson  Jandir  de  Souza  -  Professor  do  Instituto  Federal  de  Educação,  Ciência  e

Tecnologia 
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1. INSTALAÇÃO DO AUTOCAD 2016

Nesse capítulo vamos mostrar como baixar a versão de teste do AUTOCAD  2016.
Inicialmente o leitor deve acessar o site AUTODESK.COM. No canto direito superior
do site acesse a opção MENU:

Figura 1.1 – Instalação do AUTOCAD 2016 - MENU

Clique na aba Products

Figura 1.2 – Instalação do AUTOCAD 2016 - Products

Na aba Products acesse a aba AUTOCAD

Figura 1.3 – Instalação do AUTOCAD 2016 – seleção do programa

Click em Free Trial  para obter a versão de teste do programa. 

Figura 1.4 – Instalação do AUTOCAD 2016
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Escolha a versão do AUTOCAD que se adequa ao seu computador, digite seu email e 
clique em DOWNLOAD TRIAL

Figura 1.5 – Instalação do AUTOCAD 2016 - cadastro

1.1- TELA INICIAL DO AUTOCAD

Quando se acessa o AUTOCAD 2016 é possível ver na parte superior do programa a 
seguinte configuração de comandos:  

Figura 1.6 –  Menu de configuração de comandos

A seguir vamos mostrar como acessar os 10 principais comandos do AUTOCAD. 

a) LINE - Desenha linhas desde que se defina um ponto inicial e um ponto final

Figura 1.7 – Comando LINE

Acesso pela tab: Draw > Line
Acesso pela barra de comando: Line ou, no modo abreviado, “L”.

Para especificar  o  primeiro ponto “Specify  first  point” podemos clicar  com o botão
esquerdo do mouse na área de desenho, ou ainda, através de coordenadas cartesianas ou
polares ex: ponto inicial (50,50) e ponto final (200,50) ou ponto inicial (50,50) e ponto
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final @150<0. O próximo ponto deve ser determinado “Specify next point”, e assim por
diante até que seja pressionada a tecla ENTER para finalizar a operação.

b) CIRCLE - Desenha um círculo

Figura 1.8 – Comando CIRCLE

Acesso pela tab: Draw > Circle
Acesso pela barra de comando: Circle ou, no modo abreviado, C

Primeiro é necessário determinar um ponto que é o centro do círculo. Esse ponto pode
ser aleatório ou um centro pré-determinado determinado bastando digitar o valor do raio
do círculo.

Opções de CIRCLE:
3P – Desenha círculo através de 3 pontos
2P – Desenha círculo através de 2 pontos
TTR – Desenha círculo tangente a dois objetos selecionados e a especificação do raio.

c) TRIM: Faz o acabamento de objetos que se interceptam. Só funciona quando
duas linhas se cruzam. Deve-se selecionar os objetos que se interceptam e a
seguir começar a cortar as arestas em excesso. 

Figura 1.9 – Comando TRIM

Acesso pela tab: Modify > Trim
Acesso pela barra de comando: Trim ou, no modo abreviado, Tr
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d) ERASE – Apaga objetos  selecionados.  Selecionar  o objeto  a  ser  apagado e
clicar em enter (ou clicar no botão da direita do mouse)

Figura 1.10 – Comando ERASE

Acesso pela tab: Modify > Erase
Acesso pela barra de comando: Erase

e) MOVE -  Move objetos selecionados.

Figura 1.11 – Comando MOVE

Acesso pela tab: Modify > Move
Acesso pela barra de comando: Move ou, no modo abreviado, M

Selecionar o objeto a ser movimentado, indicar um ponto de apoio (um clique no mouse
no  botão  da  esquerda)  e  indicar  onde  deve  ser  posicionado  o  objeto  que  se  está
movimentado.

f) OFFSET - DUPLICA objetos existentes para dentro ou para fora a partir da
distância especificada.

Figura 1.12 – Comando OFFSET
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Acesso pela tab: Modify > Offset
Acesso pela barra de comando: Offset ou, no modo abreviado, O

Indicar a distância do novo objeto, selecionar sobre o objeto a ser duplicado e indicar o
lado para onde deva ficar o mesmo.

g) ROTATE -  Rotaciona  objetos  selecionados  ao  redor  de  um ponto  de  apoio
determinado.

Figura 1.13 – Comando ROTATE

Acesso pela tab: Modify > Rotate
Acesso pela barra de comando: Rotate ou, no modo abreviado, Ro

Selecionar o objeto a ser rotacionado.  Indicar um ponto de apoio e finalizar a rotação,
indicando um ângulo de giro.

h) COPY - Copia objetos selecionados.

Figura 1.14 – Comando COPY

Acesso pela tab: Modify > Copy
Acesso pela barra de comando: Copy ou, no modo abreviado, Co

Selecionar o objeto a ser copiado.  Indicar u ponto de apoio do objeto e finalmente
clicar onde deve se localizar a cópia.
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i) FILLET  -  Modifica  as  extremidades  de  objetos  de  modo  a  torná-las
arredondadas

Figura 1.15 – Comando FILLET

Acesso pela tab: Modify > Fillet
Acesso pela barra de comando: Fillet

Selecionar as extremidades de duas retas que se cruzam. Digitar R, e indicar o RAIO
<enter>. Repetir o acionamento do comando fillet e arredondar as extremidades.

 

j) LAYERS  -  Cria  camadas  sobrepostas  no  desenho  com  propriedades
diferenciadas.

Figura 1.16 – Comando LAYERS

Na caixa de diálogo, indique se deseja uma nova camada, qual seu nome e suas 
propriedades;

k) DIMENSION – o comando dimension permite que sejam aplicadas as medidas
no objeto que está sendo desenhado.

No desenho em 2D há dois sistemas de coordenadas:  cartesianas  e polares.  No
sistema  de  coordenadas  cartesianas  os  desenhos  são  construídos  a  partir  de  pares
ordenados (a,b) onde “a”  significa a distância a partir de uma origem na horizontal e
“b”  significa  a  distância  a  partir  da  origem na  posição  vertical.   Já  no  sistema  de
coordenadas polares é possível a entrada de informações de construção de uma linha
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apresentando a sua distância em relação a um ponto inicial e indicando o ângulo em
relação à horizontal (@DISTÂNCIA<ANGUL0, como o exemplo: @60<0).

2- EXEMPLO DE APLICAÇÃO – PEÇA 1

A seguir, mostramos o passo-a-passo para se desenhar uma peça utilizando os
principais comandos do AutoCAD 2016. Devem ser desenhadas as 3 vistas ortogonais
da peça mostrada na figura a seguir.  Para quem não está familiarizado com a técnica de
vistas ortogonais deve dar uma olhada no anexo. 

Figura 2.1 – Perspectiva da peça 1

 As  3  vistas  ortogonais  são  desenhadas  com  as  medidas  disponibilizadas  a
seguir: 
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Figura 2.2 – Vistas da peça 1

Antes de executar o desenho é importante fazer algumas configurações no 
AUTOCAD. Isso facilitará a execução posterior do desenho. Veja no VÍDEO a 
explicação passo a passo: 

https://www.youtube.com/watch?v=HuH7MgEap6s  - Configurando o AutoCAD 

https://www.youtube.com/watch?v=6AqXMA0IOIM  - Desenho da peça 1
a) Configure os tipos de linhas que serão utilizados nas PROPRIEDADES DE 

CAMADA. 

Figura 2.3 – Propriedades das camadas

A seguir configure os comandos de PRECISÃO mostrados a seguir. Basta clicar
nas teclas F2 para ter acesso a essas configurações. Com os comandos de precisão as
linhas serão atraídas para a posição desejada (meio, centro, extremidade etc). 
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Figura 2.4 – Comandos de precisão

Uma vez realizadas essas configurações, vamos ao desenho. Clique no ícone 
LINE no menu superior.  

Figura 2.5 – Comando LINE

Na  Linha  de  comando  (parte  inferior  da  tela)  aparece  a  mensagem:  LINE
Specify first point: (ESPECIFIQUE O PRIMEIRO PONTO DA LINHA).

Figura 2.6 – Comando LINE

Toda linha deve ter um ponto inicial e um ponto final.  No sistema cartesiano
podemos definir as coordenadas (x,y) do primeiro ponto (PONTO A) como sendo 10,10.
O retângulo que representa a vista superior da peça tem dimensões de 32 cm por 20 cm.
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Nesse  caso,  o  ponto  final  (PONTO B)  tem dimensões  (42,10).   O PONTO C tem
coordenadas  (42,30) e o PONTO D tem coordenadas (10,30).  

Figura 2.7 – Vista superior

O AutoCAD trabalha com medidas unitárias, não importando se são 10cm ou
100m. No momento da impressão / plotagem essa preocupação aparece na definição das
escalas. Se imprimimos 100 cm reais como sendo 2cm reais, então a escala usada é de 1
para 50. Ou seja, cada 1cm vale 50cm na realidade. 

Uma vez confirmado o ponto inicial (PONTO A = 10,10), mantenha a tecla F8
do teclado ativada. Essa tecla permite construção de linhas ortogonais. A seguir digite o
comprimento do segmento de reta AB, que é de 32.  

Figura 2.8 – Reta AB

Com um leve toque no mouse direcionamos a próxima linha para a vertical e
para cima. Com F8 ainda ativado digite 20, que é a medida do segmento de reta BC.
Mais uma vez dê um leve toque no mouse para posicionar a linha auxiliar (tracejada) na
horizontal e digite 32, que é a medida do segmento de reta CD. Faça o mesmo para o
segmento DA digitando 20 para fechar o retângulo.
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Figura 2.9 – Construção do retângulo

Usando  o  comando  auxiliar  ZOOM  (na  linha  de  comando)  e  WINDOW
podemos  posicionar melhor o desenho na tela ampliando o retângulo. 

                                    
Figura 2.10 – Comando ZOOM

No sistema cartesiano podemos definir as coordenadas do ponto I como sendo
(52,40). A vista lateral esquerda da peça tem dimensões de 20 cm por 10cm.  Nesse
caso, o ponto J tem coordenadas (72,40), o ponto K tem coordenadas (72,50), o ponto L
tem coordenadas (52,50). 
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Figura 2.11 – Vistas da peça 1

Como  resultado,  temos  apenas  os  contornos  externos  das  vistas  (superior,
frontal e lateral). Trace uma linha do ponto H até o segmento de reta AB. 

Figura 2.12 – Vistas da peça 1

Utilizamos o comando TRIM  para apagar parte da linha que não nos interessa.

Figura 2.13 – Comando TRIM
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Selecionamos  o  desenho  conforme  desenho  sombreado  abaixo.   Para  isso,
posicione  o  cursor  do  mouse  um pouco  abaixo  do  ponto  B  e  clique  com o  botão
esquerdo do mouse.  Movimente até  envolver  todo o desenho e clique  com o botão
esquerdo novamente. Clique em ENTER. Depois você deve clicar sobre a parte que
precisa ser aparada.

Figura 2.14 – Comando TRIM

Para concluir o comando de TRIM (APARAR), clique em ENTER.  

Para finalizar o contorno da vista devemos usar o comando ERASE (APAGAR).

Figura 2.15 – Comando ERASE
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Para centralizarmos o círculo, traçar duas diagonais na metade direita da vista 
superior.

                                                                 
Figura 2.15 – Centralizar o furo

Acionar o comando CÍRCULO, conforme indicado na Figura:  O círculo tem 
diâmetro de 8cm. Devemos indicar o raio de 4cm a partir do centro. 

Figura 2.16 – Comando CIRCLE

Figura 2.17 – Comando CIRCLE

Apagar as duas diagonais com o comando ERASE.
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Figura 2.18 – Comando ERASE

Traçar duas linhas verticais partindo das tangentes do círculo até a vista superior.
Essas linhas vão representar o furo passante na vista superior. Essas linhas são chamadas
de linhas auxiliares e devem ser tracejadas.

Figura 2.19 – Projeção do furo na vista frontal

O desenho das duas linhas é mostrado abaixo. Devemos aparar as linhas que não
são necessárias com o comando TRIM.  Vamos usar o comando COPY para representar
na vista lateral o tracejado (que representa o furo passante).  

Vamos  configurar  o  tipo  de  linha  digitando  o  comando  LINETYPE  na  barra  de
comandos.  

Figura 2.20 – Comando LINETYPE
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Uma nova janela será aberta.  Solicitamos para o AUTOCAD 2016 carregar os 
tipos de linhas. 

Figura 2.21 – Comando LINETYPE

Escolher a linha ISO DASH SPACE e clicar em OK. 

Figura 2.22 – Comando LINETYPE

18



Uma vez carregado o tipo de linha tracejada, basta selecionar as duas linhas com
o mouse (botão esquerdo) e clicar em PROPERTIES > ByLayer > ACAD_ISO.

Figura 2.23 – Seleção do tipo de linha

Para copiarmos as duas linhas tracejadas da vista frontal para a vista lateral é
preciso escolher um ponto de apoio. Por isso, vamos traçar as diagonais a seguir. 

Figura 2.24 – Seleção do tipo de linha

Vamos copiar as duas linhas tracejadas para a vista lateral. Para isso clicamos em
COPY. Selecionamos as duas linhas e clicamos em ENTER. Clicamos com o botão
esquerdo no cruzamento das diagonais internas das duas linhas tracejadas. Clicamos
agora no centro das duas diagonais da vista lateral.
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Figura 2.25 – Comando COPY

Com isso copiamos as duas linhas verticais que representam o rasgo passante do 
cilindro, também na vista lateral.

Figura 2.26 – Comando COPY

Para o desenho ficar completo precisamos ainda desenhar as linhas de centro do
furo, escrever os nomes das vistas e inserir as linhas de cota (de medida). Você também
já viu que para configurar uma camada é necessário clicar em LAYER PROPERTIES.
Uma nova tela será aberta. 

Figura 2.27 – LAYER PROPERTIES

Você deve escolher criar uma nova camada e definir nome e cor das linhas da 
camada. Vamos criar três camadas: uma para TEXTO, outra para COTAS e outra para 
linhas de eixo.
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Figura 2.28 – LAYER PROPERTIES

Clique em New Layer, e crie os 3 tipos de linhas necessárias para o desenho e 
clicando sobre as cores escolha uma para cada tipo de linha, escolha também o tipo de 
linha a ser usado em cada parte do desenho.

Figura 2.29 – LAYER PROPERTIES

3- EXEMPLO DE APLICAÇÃO – PEÇA  2

É muito importante, antes de começar a desenhar, entender a peça em 3
dimensões para saber o que se está fazendo. O desenho isométrico pode ser
visualizado a direita.  Acompanhe o texto com o vídeo recomendado: 

https://www.youtube.com/watch?v=uL2UyP2bas8

Figura 3.01 – Peça 2
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Inicialmente sugerimos que o leitor limite a área do desenho. Digite na
barra de comandos: LIMITS. O programa solicita que você insira as coordenadas
do canto inferior esquerdo. Digite 0,0. Depois insira as coordenadas do canto su-
perior  direito:  Digite  250,150.  Para  visualizar  toda  a  área  de  trabalho  digite
ZOOM e escolha a opção ALL (toda área).

O desenho deve ser iniciado a partir dos três quadrados ilustrados abaixo.
Eles serão construídos com os comandos LINHA ou LINE. Você pode escrever a
tecla de atalho L ou clicar no ícone no menu superior. As medidas de cada qua-
drado são 40 x 40. 

Figura 3.02 – Comando LINE

Configure o programa em OSNAP SETTINGS (menu inferior)  para que seja
possível encontrar o MEIO (MIDPOINT) de uma linha. Com isso você conseguirá dese-
nhar um circulo na linha de baixo do quadrado superior.

Figura 3.03 – MIDPOINT
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Para construir o círculo, utilize o comando CIRCLE. Primeiro escolha o ponto 
central do círculo de depois digite o RAIO: 15. 

Figura 3.04 – Comando CIRCLE

Com o comando TRIM (aparar) você pode cortar o que não é necessário na figu-
ra.

Novamente com o comando LINE trace as linhas necessárias:

Figura 3.05 – Comando LINE
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Utilize o comando TRIM novamente para aparar as linhas desnecessárias. 

Figura 3.06 – Comando TRIM

Seu desenho deverá ficar como o seguinte:

Figura 3.07 – Vistas da peça 2

Crie as camadas para organizar a construção das cotas e dos textos:  Acesse 
LAYER PROPERTIERS. Crie uma linha tracejada.

Figura 3.08 – Criar linha tracejada
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Figura 3.09 – Criar linha tracejada

Basta clicar sobre a linha já existente e escolher a LAYER da linha tracejada e 
clicar ENTER. 

Figura 3.10 – Criar linha tracejada
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Para dimensionar o desenho selecione em DIMENSION STYLE. Escolha o 
tamanho dos textos e das setinhas da linha de cota.

Figura 3.11 – Cotas

A opção necessária e MODIFY (modifica): 

Figura 3.12 – Cotas - MODIFY
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Figura 3.12 – Cotas - MODIFY
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4- EXEMPLO DE APLICAÇÃO – PLANTA BAIXA

Vamos  agora  desenhar  passo-a-passo  uma  planta  baixa  para  fixação  do
conhecimento. 

Figura 4.1 – Planta baixa

a. LIMITS:  limitar tamanho do desenho 

canto inferior esquerdo (lower left corner)   = inicio do desenho  ---ex:  0,0

canto superior direito (upper right corner)  =  largura, altura   ------ ex:  3000,2000

Digite zoom (enter) e  all (enter) para visualizar toda área de trabalho.

b. LINE: desenha as linhas externas das paredes

from point – ponto de origem ----ex: 500,500

to point ------ponto final -----------ex: 1415,500   

to point ------ponto final -----------ex: 1415,1190

to point ------ponto final -----------ex: 500,1190

to point ------ponto final -----------ex: 500,500

ou ainda: digitando ponto inicial (from point) 500,500 e depois:

28



@915<0    e   @690<90   e   @915<180   e  @690<-90

500,500 1415,500

1415,1140500,1140

PONTO 
INICIAL

EIXO X

EIXO Y

VALOR 
DE X

VALOR
DE Y

CONTORNO DA CASA

Figura 4.2 – Comando LINE

c. OFFSET: duplicar as linhas externas de uma distância de 15 cm 
para dentro

Com OFFSET acionado, faz-se as divisões internas da casa

Ex:  acionar  comando  OFFSSET –  indicar  distância  =  15,   clicar  sobre  a  linha
externa  e  depois  clicar  sobre  o  lado  interno  da  casa.  –  Repetir  a  operação  até
concluir as paredes – (acionar offset – indicar, por exemplo, 325 a partir da parede
interna,  indicar  a  parede  interna  e  clicar  para  o  lado  de  dentro  da  casa  para  a
primeira parede) 

COMANDO OFFSET A 325 cm 
DA LINHA INTERNA DA 
PAREDE

Figura 4.3 – Comando OFFSET

Fazendo-se todas as paredes, tem-se o seguinte desenho:
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Figura 4.3 – Comando OFFSET
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d. TRIM: Devemos cortar as linhas em excesso
Selecionar TRIM, marcar todo o desenho apertando 1 vez o botão esquerdo do 

mouse a partir do lado direito do desenho, arrastar o mouse sem apertar e apertando 
mais uma vez o botão esquerdo do lado esquerdo do desenho. Apertar ENTER e 
começar a cortar as linhas que devem desaparecer com o botão esquerdo. O 
resultado é visualizado a seguir:

Figura 4.4 – Comando TRIM

e. ERASE: Apagar  os restos do desenho (ex: pilar no meio da sala etc)
Acionar ERASE e indicar o que deve ser apagado clicando em ENTER no final.

Figura 4.5 – Comando ERASE

As intersecções entre as paredes que sobraram devem ser removidas a qualquer 
momento usando TRIM.

f.  CIRCLE: Traçar um círculo a partir da porta
Inicialmente, marcar a portas a 10 cm das paredes com o comando OFFSET

(Portas externas = 90 cm, de banheiros = 70 cm e as outras de 80 cm)
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Figura 4.6 – Comando CIRCLE

Acionar  CIRCLE –  a  linha  de  comando  solicitará  a  indicação  do  centro  da
circunferência. Marcar o centro da circunferência através do comando de precisão
SHIFT+BOTÃO  DA DIREITA apertados   de  forma  simultânea,  solte  quando
aparecer o menu flutuante e escolha a seguir a opção intersection com um clique no
botão  da  esquerda.  Procure  o  ponto  central  da  circunferência  no  seu  desenho e
aperte o botão da esquerda quando o cursor estiver sobre ele. Escreva o valor do raio
do círculo (45 cm = METADE do tamanho da porta = 90 cm).

O resultado é visualizado a seguir. 

Figura 4.7 – Comando CIRCLE

Pode-se fazer as aparas necessárias e obter o desenho a seguir.  É conveniente 
utilizar o comando ZOOM – W para visualizar mais proximamente os detalhes do 
desenho – Note que usamos também o OFFSET para representar a espessura da 
porta = 3cm.
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Figura 4.8 – Porta

g.  LAYERS: Constrói  camadas  sobrepostas  ao  desenho  para  representar  portas,
janelas, cotagem e texto.  Cada uma destas entidades pode ter propriedades próprias
como cor, tipo de linha etc. Acione o comando LAYER (sempre via teclado ou ícone
disponível) e espere a abertura do menu flutuante. Escolha a opção NEW e indique o
nome da nova camada – exemplo JANELAS (enter ao final) – clique sobre o último
dos  quadrados  coloridos  para  escolher  a  cor  da  linha.  Para  acionar  este  tipo  de
camada aperte em CURRENT.

h. DIMENSION – LINEAR: Para colocar as medidas no desenho. 

Acione DIMENSION - LINEAR e indique o ponto inicial do ambiente a ser 
cotado. Após faça o mesmo para o ponto final – sempre com a ajuda do 
comando de precisão (SHIFT+BOTÃO DA DIREITA – INTERSECTION)

Figura 4.9 – Cotas
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i. MULTILINE TEXT: 
Marque a área necessária para o texto de depois digite as informações conforme segue: 
(note que se pode variar de uma layer para outra através da tela de menu flutuante 
disponível)

SALA

BANHO

QUARTO COZINHA

Figura 4.10 – Comando MULTILINE TEXT

j. MOVE: Movimentar o texto, centralizando-o no ambiente.
Selecionar MOVE e indicar o objeto a ser movimentado. Marcar um ponto de

apoio próximo ao objeto e fazer a movimentação. 

Os comandos COPY e ROTATE são utilizados, por exemplo, para não se fazer
operações repetitivas, como a de desenhar as diversas portas no desenho. Uma outra
forma de se economizar tempo é criar uma biblioteca de peças mais usadas.  

Para se representar as janelas é preciso primeiro posicioná-la nos ambientes. Se
elas estiverem centralizadas traça-se o ponto médio da linha da parede. Depois é
necessário se marcar metade da largura da janela para cada lado. Essa operação é
complementada com o uso da LAYER correta, preparada previamente. Na plotagem
a janela é indicada com uma pena mais fina que a da parede.
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Figura 4.11 – Planta baixa

Desenho obtido ainda sem a representação das janelas e portas.

5-  NOVIDADES NO AUTOCAD 2016.

a. NOVOS COMANDOS
i. GLOSEALLOTHER

Fecha todos os arquivos abertos, menos o que está sendo usado.

ii. CMATTACH
Insere referências a modelos de coordenação (arquivos NWD e NWC 

Navisworks).

iii. DIGITALSIGN
Fornece um comando separado para conferir assinatura digital a um 

desenho.
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iv. GOTOSTART
Muda para a aba Start.

v. PCEXTRACTCENTERLINE
Desenha linha de centro para um cilindro em uma nuvem de pontos.

vi. PCEXTRACTCORNER
Indica um ponto de inserção entre três planos detectados em uma nuvem 

de pontos

vii. PCEXTRACTEDGE
Indica a aresta entre dois planos com uma linha desenhada

viii. PCEXTRACTSECTION
Gera uma forma 2D a partir de uma nuvem de pontos que contém objetos

em corte

ix. POINTCLOUDCROPSTATE
Comanda como excluir, salvar e restaurar estados de recorte da nuvem de

pontos

x. RENDERENVIRONMENTCLOSE
Fecha a paleta Render Environment & Exposure

xi. RENDERWINDOW
Abre a janela Render Window (substituto do comando RENDERWIN)

xii. RENDERWINDOWCLOSE
Fecha a janela Render Window

xiii. SCRIPTICALL
Executa a sequencia de comandos como o comando SCRIPT, podendo 

também executar os scripts aninhados

xiv. SECTIONSPINNERS
Define o valor padrão do incremento para os controles de Section Offset 

e SLice Thickness na tab 

xv. SYSVARMONITOR
Exibe caixa de diálogo do System Variable Monitor
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b. FILE TABS

A New Tab foi renomeada para Start permanecendo na tela quando são criados ou 

abertos arquivos.

Figura 5.1 – Start

c. LAYOUTS
Agora é possível arrastar e soltar para mover ou copiar os layouts para as 

posições escondidas no menu.

Figura 5.2 – Layouts

Para copiar um layout existente basta pressionar Ctrl enquanto arrasta.

Ao clicar com o botão direito do mouse sobre um layout, um novo controle de 

interface foi adicionado ao menu permitindo definir se as tabs ficarão alinhadas com a 

Status Bar ou se ficarão acima dela.
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Figura 5.3 – Alinhamentos das tabs

Layouts acima da Status Bar:

Figura 5.4 – Alinhamentos das tabs

Layouts alinhados com a  Status Bar:

- 

Figura 5.5 – Alinhamentos das tabs

d. RIBBON

GALLERYVIEW permite que controlar se as galerias são mostradas. Quando a variável

de sistema GALLERYVIEW está definida com valor <1> aparecerá os previews das 

imagens dos blocos, estilos de cotas, mleaders e tabelas.
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Figura 5.6 – GALLERYVIEW

e. OBJECT SNAP GEOMETRIC CENTER

Agora  é  possível  capturar  o  centro  geométrico  das  figuras  como  polígonos,

polilinhas e splines. Essa função pode ser ativada no ícone da Status Bar,  digitando

OSNAP na barra de comandos ou clicando na Shift + botão direito do mouse. Na Status

Bar:

Figura 5.7 – OSNAP
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Na barra de comandos:

Figura 5.8 – OSNAP

Figura 5.9 – OSNAP
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A exibição desse novo objeto snap é da seguinte forma: 

Figura 5.10 – Exibição OSNAP

f. DIMENSION - COTAS
O painel de cotas está localizado na tab Annotate, no painel Dimension.

Figura 5.11 – Cotas

No AUTOCAD 2016 o comando DIMENSION apresentou diversas melhorias. Ao 

acionar o comando DIM aparecem na barra as opções disponíveis de cota.
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Figura 512 – Comando DIMENSION

A melhoria está no fato de que não é mais necessário pré-definir qual das opções de

cotas se pretende usar, o programa cria automaticamente o tipo de cota mais indicado

para aquela superfície ou objeto selecionado. Antes de definir a cota temos acesso a uma

pré-visualização para aí sim confirmar a cota.

Figura 5.13 – Cotas

Figura 5.14 – Cotas

Para cotar um ângulo basta selecionar uma reta e depois outra não paralela.
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Figura 5.15 – Cotas

g. EXPORTAR ARQUIVOS

Ocorreram melhorias no suporte ao PDF.

Na tab output podemos acessar a opção Export to PDF:

Figura 5.16 – Exportar arquivos pdf

Ao clicar nessa opção é possível controlar a qualidade e manipulação das fontes, 

hiperlinks e marcadores.
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Figura 5.17 – Exportar arquivos pdf

DOCUMENTAÇÃO

REVCLOUD: As nuvens de revisão são encontradas na ribbon Annotate no painel 

Markup

Figura 5.18 – Revcloud

Podendo ser escolhido entre 3 métodos de criação: Rectangular, Polygonal, Freehand.
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Figura 5.19 – Revcloud
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6- COMANDOS E ATALHOS DO AUTOCAD EM INGLÊS E PORTUGUÊS

INGLÊS ATALH
O 

PORTUGUÊS ATALH
O 

DEFINIÇÃO 

3DARRAY 3A MATRIZ3D M3 Cria uma matriz 3D 
3DFACE 3F FACE3D F3 Cria uma superfície de três ou quatro lados em 

no espaço 3D 
3DORBIT 3DO ORBITA3D O3D Controla a visualização interativa de objetos em 

3D 
3DPOLY 3P POLI3D P3 Cria uma polilinha 3D 
ALIGN AL ALINHAR AL Alinha objetos com outros objetos em 2D e 3D 
ARC A ARCO A Cria um arco 
AREA AA AREA AA Calcula a área e o perímetro de objetos ou de 

áreas definidas 
ARRAY AR MATRIZ  MA Cria diversas copias de objetos dentro de um 

padrão 
BLOCK B BLOCO CB Cria blocos a partir de objetos selecionados 
BOUNDARY BO LIMITE LIM Cria uma polilinha a partir de uma área 

delimitada 
BREAK BR QUEBRAR QU Quebra o objeto selecionado entre dois pontos 
CHAMFER CHA CHANFRO CHA Chanfra as arestas de objetos 
CIRCLE CHA CIRCULO CI Cria um círculo 
COPY CO COPIAR CO  Copia objetos em uma distância e uma direção 

específicas 
DIMALIGNE DAL COTAALIN COA Cria uma cota linear alinhada 
DIMANGULAR DAN COTAANG CANG Cria uma cota angular 
DIMBASELINE DBA COTALINBASE CLB Cria uma cota linear, angular ou de ordenada a 

partir da linha de base da cota anterior ou de 
uma cota 

DIMCENTER DCE COTACENTRO CCE Cria a marca de centro ou as linhas de centro de 
círculos e arcos 

DIMCONTINUE DCO COTASERIE CSE Cria uma cota linear, angular ou de ordenada 
que inicia na segunda linha de extensão da cota 
anterior ou de uma cota selecionada 

DIMDIAMETER DDI COTADIAMETR
O 

CDI Cria uma cota de diâmetro para um círculo ou 
um arco 

DIMEDIT DED EDITARCOTA EDC Edita o texto da cota e as linhas de extensão 
DIMLINEAR DLI COTALINEAR CLI Cria uma cota linear 
DIMORDINATE DOR COTAORDEN COO Cria cotas de ordenada 
DIMOVERRIDE DOV SOBRECOTA SCO Sobrepõe variáveis do sistema de cotagem 
DIMRADIUS DRA COTARAIOS CRA Cria uma cota de raio para um círculo ou arco 
DIMSTYLE D ESTILOCOTA EC Cria e modifica os estilos de cota 
DIST DI DIST DI Mede a distância e o ângulo entre dois pontos 
DIVIDE DIV DIVIDIR DIV Posiciona objetos de ponto ou blocos espaçados 

de maneira uniforme ao longo do comprimento 
ou perímetro de um objeto 

DONUT DO ANEL NA Cria círculos e circunferências preenchidos 
DRAWORDER DR  ORDEMDES ODE Altera a ordem de desenho de imagens e de 

outros objetos 
DSVIEWER AV VIZUALIZD AV Abre a janela Aerial View 

DVIEW DV VISTAD VD Define uma projeção paralela ou vistas em 
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perspectiva 
ELLIPSE EL ELIPSE EL Cria uma elipse ou um arco elíptico 
ERASE E  APAGAR APG Remove objetos de um desenho 
EXPLODE X EXPLODIR X Quebra um objeto composto em objetos 

componentes 
EXPORT EXP EXPORTAR EXP Salva objetos em outros formatos de arquivo 
EXTEND EX  ESTENDER EST Estende os objetos para encontrar com as arestas

de outros objetos 
EXTRUDE EXT EXTRUSAO EX  Cria um sólido ou superfície 3D ao efetuar a 

extrusão de um objeto 2D 
FILLET F CONCORD CNC Arredonda e faz a concordância das arestas de 

objetos 
FILTER FI FILTRO FI Cria uma lista de requisitos necessários a um 

objeto para ser incluído em um conjunto de 
seleção 

GROUP G GRUPO G Cria e gerencia conjuntos de objetos gravados 
chamados grupos 

HATCH H HACHURA H Preenche uma área delimitada ou objetos 
selecionados com uma trama padrão, 
preenchimento sólido ou preenchimento de 
gradiente 

HATCHEDIT HE EDITARHATCH EH Modifica uma trama ou preenchimento existente
HIDE HI OCULTAR O Regenera um modelo de estrutura de arame 

tridimensional, omitindo linhas ocultas 
IMAGE IM IMAGEM IM Exibe a paleta External References 
INSERT I  INSERIR I  Insere um bloco ou um desenho no desenho 

atual 
INTERFERE INF INTERFERE INF Realça os sólidos 3D que se sobrepõem 
INTERSECT IN INTERSEC INT Cria um sólido 3D ou uma região 2D a partir de 

seu volume ou área sobreposta  
LAYER LA CAMADA CA  Gerencia camadas e suas propriedades 
LEADER LE LINHACHAMR LC Cria uma linha que conecta a anotação a um 

elemento 
LENGTHEN LEN ALONGAR ALO Altera o comprimento de objetos e o ângulo dos 

arcos incluídos 
LINETYPE LT TIPOLINHA TL Carrega, define e modifica tipos de linha 
LIST LI / LS LISTA LI / LS Exibe os dados da propriedade para os objetos 

selecionados 
LTSCALE LTS ESCALATL ETL Define o fator de escala do tipo de linha 

universal 
MATCHPROP MA PROPIG PI Aplica as propriedades de um objeto selecionado

a outros objetos 
MEASURE ME MEDIDA ME Posiciona objetos de ponto ou blocos em 

intervalos medidos em um objeto 
MIRROR MI ESPELHAR ESP Cria uma cópia espelhada dos objetos 

selecionados 
MLINE ML MLINHA ML Cria multilinhas paralelas 
MOVE M MOVER M Move objetos em uma distância e uma direção 

especificadas 
MTEXT T TEXTOM T  Cria um objeto de texto de múltiplas linhas 
OFFSET O DESLOCAMENT

O 
  Cria círculos concêntricos, linhas paralelas e 

curvas paralelas 
OPTIONS OP OPCOES OP Personaliza as configurações do programa 
OSNAP OS OSNAP OS Define a execução dos modos de snap a objeto 
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PAN P PAN P Move a vista na viewport atual 
PEDIT PE EDITARP EDP Edita as polilinhas e as malhas poligonais 3D 

PLINE PL PLINHA PL Cria uma polilinha 2D 
PLOT PRINT PLOTAR IMPRI

MIR 
Plota um desenho para uma plotadora. 
Impressora ou arquivo 

POINT PO PONTO PO Cria um objeto de ponto 
POLYGON POL POLIGONO POL Cria uma polilinha fechada equilátera 
RECTANGULE REC RETANGULO RET Cria uma polilinha retangular 
REDRAW R  REDESEN RD Atualiza a exibição na viewport atual 
REDRAWALL RA REDESTUDO RDT Atualiza a tela em todas as viewports 
REGEN RE  REGEN RG Regenera o desenho inteiro a partir da viewport 

atual 
REGENALL REA REGENTUDO RGT Regenera o desenho e atualiza todas as 

viewports 
REGION REG REGIAO REG Converte um objeto que envolve uma área em 

um objeto de região 
RENDER RR RENDER   Cria uma imagem com aplicação de cor 

realística ou com realismo fotográfico de uma 
estrutura de arame tridimensional ou de um 
modelo sólido 

REVOLVE REV   REVOLUCAO REV Cria um sólido ou superfície 3D ao varrer um 
objeto 2D em torno de um eixo 

ROTATE RO ROTAC RO Rotaciona os objetos ao redor de um ponto base 
SCALE SC ESCALA  ES Amplia ou reduz os objetos selecionados, 

mantendo as mesmas proporções do objeto após 
o redimensionamento 

SCRIPT SCR SCRIPT SCR Executa uma sequência de comandos a partir de 
um arquivo de script 

SECTION SEC SECAO SEC Utiliza a intersecção entre um plano e sólidos 
para criar uma região 

SLICE SL FATIAR FAT Corta um sólido com um plano ou uma 
superfície 

SNAP SN SNAP SN Restringe o movimento do cursor a intervalos 
especificados 

SOLID SO SOLIDO SO Cria triângulos e quadriláteros com 
preenchimento sólido 

SPELL SP ORTOGRAF OR Faz a verificação ortográfica em um desenho 
SPLINE SPL SPLINE SPL Cria uma curva suave que passa através, ou 

perto, de pontos selecionados 
SPLINEEDIT SPE EDITARSPLINE ESPL Edita uma spline ou uma polilinha de ajuste à 

spline 
STRETCH S ESTICAR E Estica os objetos cruzados por uma janela ou 

polígono de seleção 
STYLE ST ESTILO  ET  Cria, modifica ou especifica estilos de texto 
SUBTRACT SU SUBTRAIR SU Combina os sólidos 3D ou regiões 2D 

selecionados por subtração 
TABLE TB TABELA TB Cria um objeto de tabela vazio 
TABLET TA MESADIG MDG Calibra, configura, ativa e desativa uma mesa 

digitalizadora conectada 
THICKNESS TH THICKNESS TH Define a espessura 3D atual. 
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ANEXO 1 – NOÇÕES DE DESENHO TÉCNICO 

A projeção de vistas ortogonais surgiu a partir do desenvolvimento da geometria

descritiva,  quando  o  matemático  Gaspard  Monge,  militar  francês  que  no  início  do

século  VIII  criou  um método  gráfico  para  representação  espacial  revolucionando  o

estudo da geometria e dando origem ao desenho através de vistas: o desenho técnico.

Da  mesma  forma  que  a  linguagem  escrita  exige  alfabetização,  a  execução  e  a

interpretação da linguagem gráfica do desenho técnico exige treinamento específico,

porque são utilizadas figuras planas (bidimensionais) para representar formas espaciais. 
Na Figura 1 ilustramos uma representação espacial por meio de figuras planas.

Para um leigo em desenho essa é a representação de 3 quadrados. Mas na linguagem do

desenho técnico essa é a representação das vistas ortogonais de um cubo.

Figura 1- Vistas ortogonais de um cubo.

Da  mesma  forma,  podemos  representar  a  peça  desenhada  em  perspectiva

isométrica na Figura 2 em 3 vistas ortogonais. É fundamental que o leitor pense como

foram obtidas  cada  uma  das  vistas  representadas  analisando  o  desenho  da  peça  (a

direita).
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Figura 2 - Ilustração de uma peça por meio da perspectiva e das vistas ortogonais.

Conhecendo-se  a  metodologia  utilizada  para  elaboração  do  desenho

bidimensional  é  possível  entender  e  conceber  mentalmente  a  forma  espacial

representada na figura plana. Na prática pode-se dizer que, para interpretar um desenho

técnico, é necessário enxergar o que não é visível e a capacidade de entender uma forma

espacial a partir de uma figura plana, chamada visão espacial. Por exemplo, fechando os

olhos pode-se ter o sentimento da forma espacial de um copo, de um determinado carro,

da sua casa etc.  Ou seja,  a visão espacial  permite a percepção (o entendimento)  de

formas espaciais, sem estarmos vendo fisicamente os objetos. Para representação das

vistas ortogonais temos que observar a posição do observador em relação ao plano de

projeção, conforme ilustramos na Figura 3. 

Figura 3- Posição do observador em relação ao plano de projeção.

Disponível no site: http://sistema-diedrico.blogspot.com.br/.

Ainda na Figura 3 podemos tirar alguns conceitos básicos de projeções. São elas: 

a) Centro de projeção: corresponde ao boneco branco. É a posição do observador; 
b) Objeto a ser observado: peça em 3D em perspectiva; 
c) Raios projetantes: linhas que ligam as projeções nos planos PV, PH e PP; 
d) Planos PV, PH e PP: são os planos onde se representada as projeções da peça; 
e) Projeção do objeto: figuras bidimensionais nos planos. 

Na Figura 4 ilustramos a forma de obtenção de uma projeção de um objeto em um

plano paralelo. 
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Figura 4- Ilustração da projeção ortogonal – vista superior.

Quando desenhamos figuras geométricas planas todos os seus pontos podem ser

descritos (posicionados) usando-se duas coordenadas X e Y no plano cartesiano. Por

exemplo, o Ponto P representado na Figura 5 tem coordenadas x = 40 e y = 50. 

Figura 5- Representação de um ponto no plano cartesiano.

Se  esse  ponto  não  estiver  posicionado  sobre  um determinado  plano,  mas  se

estiver no espaço, temos a situação representada na Figura 6. Após a projeção ocorre o

rebatimento dos planos de perfil e horizontal (planificação). É a partir deste momento

que  nos  valemos  da  geometria  descritiva.  Ou  seja,  os  três  planos  são  rebatidos  e

representados em um único plano. Este processo é chamado de Rebatimento de Planos. 

Figura 6- Representação da projeção de um ponto P nos planos de projeção.
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Podemos dividir um ângulo de 360 graus em 4 ângulos de 90 graus chamados de

diedros. Eles são numerados no sentido anti-horário e denominados de 1o, 2o, 3o  e 4o

diedros.
Compreendemos  que  a  representação  no  primeiro  diedro  se  mostra  mais

conveniente para o desenho técnico, mas há autores, normalmente dos Estados Unidos

da América, que adotam representação no 3º diedro.

De acordo com sua posição, relativa aos planos de projeção, o segmento de reta

recebe um nome. Nas Figuras 7 e 8 representamos um cubo. Nele podemos visualizar

vários  segmentos:  Horizontal  ou  de  nível  –  segmento  BD; Frontal  ou  de  frente  –

segmento BC; Fronto-horizontal ou paralela à linha; de terra – segmento AB; Vertical –

segmento AC; De topo ou de ponta – segmento AD; De perfil – segmento DC; Qualquer

– segmento BE (passando pelo interior do cubo).

Figura 7- Ilustração de representação de linhas no 1º diedro.

Cada tipo de segmento ao projetar-se num plano de projeção sua projeção poderá

ser: um segmento de mesmo tamanho, quando está paralelo ao plano de projeção; um

segmento de tamanho reduzido, quando está inclinado com relação ao plano de projeção

ou apenas um ponto, quando está perpendicular ao plano de projeção.  Para facilitar o

entendimento a projeção no plano frontal é acompanhada do número 1, as no plano

horizontal pelo número 2 e as no plano de perfil pelo número 3. 
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Figura 8 – Ilustração das projeções obtidas.
Um plano pode ser  representado por,  no mínimo,  três  pontos  e  pode ocupar

várias  posições  espaciais  relativas  aos  três  planos  de  projeção.  De acordo  com sua

posição  relativa  aos  planos  de  projeção  recebem  nomes  diferentes.  Na  Figura  9

podemos  identificar  cada  uma das  faces  do  cubo:  Horizontal  –  ABCD, De perfil  –

ADEF e Frontal – ABG.

 

G

C

B

A

D

F

P.H.

E

Figura 9- Ilustração de um cubo representado no 1º diedro.

Representamos na Figura 10 as representações do objeto (cubo) nos planos horizontal,

frontal e de perfil. 
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Segmento de plano
   de perfil - ADEF

Segmento de plano
    frontal - ABGF

Segmento de plano
 horizontal - ABCD

AD 

FE 

D C A B A DA B A B

D E

F G F EGF

A FBA

B C D C

CD

BA

A D

Figura 10 – Representação das projeções do cubo.

Na Figura 11 é possível visualizar outro exemplo de obtenção das projeções de um

objeto. 

De topo - CBEF

B

FB

C

P.H.

F

E

C

E

CE

E F

C B

BF

F G

D

F

C

G

D C D C

F G
D

F

P.H.

G

C

De rampa - DCGF

Figura 11 – Projeções de objetos no plano.

Concluímos que para cada tipo de segmento projetado no plano podemos ter: 1 -

um segmento de reta, quando está perpendicular ao plano de projeção; 2 - um segmento

de plano com a mesma forma, porém de tamanho reduzido, quando está inclinado com

relação ao plano de projeção; 3 - um segmento de plano com o mesmo tamanho, quando

está paralelo ao plano de projeção.

Como os sólidos são constituídos de várias superfícies, as projeções ortogonais

são utilizadas para representar as formas tridimensionais através de figuras planas. Na

prática usaremos um número de vistas que seja suficiente para representar a peça. Na
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Figura 12 observamos que os 3 objetos possuem a mesma projeção no plano vertical.

Por isso é fundamental também a representação no plano horizontal para diferenciá-las.

Figura 12- Projeções no plano vertical e horizontal.

Na Figura 13 mostramos a representação da peça em suas três vistas ortogonais,

projetadas nos três planos do primeiro diedro. 

Figura 13- Obtenção das vistas ortogonais de uma peça no primeiro diedro.
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Figura 14- Obtenção das vistas ortogonais de uma peça no primeiro diedro.

Também é comum que as três vistas sejam apresentadas para que o desenhista

elabore a perspectiva. Para os iniciantes, esta atividade é um desafio e muito útil para

desenvolver um raciocínio lógico e tridimensional. Vejamos os três exemplos da Figura

15.

Figura 15 – Exemplos de projeções ortogonais com suas respectivas perspectivas

isométricas.

Como  vimos  na  Figura  12,  a  indexação  de  números  ou  letras  facilita  a

construção  das  projeções  ortogonais  e,  também,  exercitam o  raciocínio  lógico.  Nas

Figuras 16 e 17 temos exemplos do uso destas indexações. 

Figura 16- Representação das três vistas ortogonais de uma peça.
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a
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Figura 17- Projeção das vistas ortogonais de uma peça com chanfro.

Nas vistas ortogonais algumas superfícies poderão ficar ocultas em relação ao

sentido de observação, como se pode ver na Figura 18. Nela, vê-se que a superfície “A”

está oculta quando a peça é vista lateralmente (direção 3), enquanto a superfície “B”

está oculta quando a peça é vista por cima (direção 2). Nestes casos, as arestas que estão

ocultas  em  um  determinado  sentido  de  observação  são  representadas  por  linhas

tracejadas. As linhas tracejadas são constituídas de pequenos traços de comprimento

uniforme, espaçados de um terço de seu comprimento e levemente mais finas que as

linhas cheias.

Figura 18- Linhas tracejadas nas arestas ocultas.

Peças  de  formato  cilíndrico  são  muito  comuns  na  área  de  refrigeração  e

climatização e precisam ser representados de forma correta nas vistas ortogonais. Para

estes tipos de peças surge a necessidade do uso das linhas  de centro e de simetria,

sempre que tiverem superfícies curvas. Estas linhas são compostas de traços e pontos

que é denominada linha de centro. As linhas de centro são usadas para indicar os eixos

em corpos de rotação e também para assinalar formas simétricas secundárias. As linhas

de centro são representadas por traços finos separados por pontos (o comprimento do
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traço da linha de centro deve ser de três a quatro vezes maior que o traço da linha

tracejada). É a partir da linha de centro que se faz à localização de furos, rasgos e partes

cilíndricas. Nas Figuras 19 e 20 são apresentados alguns exemplos de aplicações da

linha de centro. 

Figura 19 - Representação correta das projeções de um cilindro.

               

Figura 20 - Representação das projeções de um eixo.

Como regra para representação, pode-se dizer que, quando não houver arestas,

uma superfície  curva  gera  linha  na  projeção  resultante  quando o  raio  da  curva  for

perpendicular ao sentido de observação (A). Se houver interseção da superfície curva

com qualquer outra superfície, haverá aresta resultante, onde tem interseção tem canto

(aresta) e onde tem canto na peça, tem linha na projeção ortogonal. 

Lembre-se também que a representação de:

 arestas e contornos visíveis deve ser executada com linha contínua grossa; 
 de arestas e contornos invisíveis deve ser executada com linha tracejada média; 
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 de eixos (de sistema, centros de furo, eixos, engrenagens e raios de 

arredondamento) deve ser executada com linha fina traço ponto. 
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ANEXO II – RESUMO DE ALGUNS COMANDOS NO AUTOCAD

COMANDO O QUE FAZ: ÍCONE

OPEN Abre um desenho existente

QSAVE Salva o desenho

NEW Cria um novo arquivo de desenho

ORTO Restringe o movimento do cursor horizontal ou verticalmente

QUIT Sai do AUTO-CAD

REDRAW Reexibe o desenho, limpando os traços de rascunho

UNDO Desfaz a última operação

LIMITS Define as delimitações do desenho

SCALE Modifica o tamanho dos objetos

ZOOM Modifica a visualização na tela do computador
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COMANDO O QUE FAZ: COMO USAR: ÍCONE

LINE Desenha  linhas
desde  que  se
defina  um  ponto
inicial e um ponto
final

Através de coordenadas cartesianas

Ou polares  ex:  ponto  inicial  (50,50)  e  ponto
final (200,50) ou ponto inicial (50,50) e ponto
final @150<0

TRIM Faz o acabamento
de objetos que se
interceptam 

Deve-se  selecionar  os  objetos  que  se
interceptam  e  a  seguir  começar  a  cortar  as
arestas em excesso

ERASE Apaga  objetos
selecionados

Selecionar o objeto a ser apagado e clicar em
enter (ou clicar no botão da direita do mouse)

MOVE Move objetos Selecionar  o  objeto  a  ser  movimentado,
indicar  um  ponto  de  apoio  (um  clique  no
mouse no botão da esquerda) e indicar onde
deve ficar o objeto movimentado.

OFFSET Cria novos objetos
a  uma  distância
especificada  de
um  objeto  já
existente

Indicar a distância do novo objeto, selecionar
sobre o objeto a ser duplicado e indicar o lado
para onde deva ficar o mesmo.

CIRCLE Desenha  um
círculo

Indicar qual o centro do círculo e indicar valor
do raio  (caso mais fácil)
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ROTATE Rotaciona  objetos
ao  redor  de  um
ponto

Selecionar o objeto a ser rotacionado. Indicar
um  ponto  de  apoio  e  finalizar  a  rotação,
indicando um ângulo de giro.

COPY Copia objetos Selecionar o objeto a ser copiado.  Indicar um
ponto de apoio do objeto e finalmente clicar
onde deve se localizar a cópia.

FILLET Modifica  as
extremidades  de
objetos de modo a
torná-las
arrendondadas

Selecionar as extremidades de duas retas que
se cruzam. Digitar R, e indicar o RAIO <enter>.
Repetir  o  acionamento  do  comando  fillet  e
arredondar as extremidades.

 

COMANDOS
DE
PRECISÃO 

permitem  criar
linhas  a  partir  de
uma extremidade,
construir  uma
linha  a  partir  da
metade  de  outra
etc.

Aperte  Shift+botão  direito  do  mouse  ao
mesmo tempo. Na caixa de diálogo, escolha o
comando de precisão desejado.

LAYERS Cria  camadas
sobrepostas  no
desenho  com
propriedades
diferenciadas

Na  caixa  de  diálogo,  indique  se  deseja  uma
nova  camada,  qual  seu  nome  e  suas
propriedades;
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ANEXO III- HISTÓRIA DO AUTOCAD

Ainda na década de 1950, antes do surgimento dos computadores pessoais, já
começaram  a  ser  utilizados  os  primeiros  protótipos  e  máquinas  para  auxiliar  no
desenvolvimento de projetos de engenharia.

http://www.action-
engineering.com/MBEDictionary/DictionaryIllustrations/Computer_Aided_Design.jpg

O nome CAD ou  Computer-aided design (desenho auxiliado por computador)
foi criado pelo cientista da computação Douglas Taylor Ross, que na época viu o quão
importante poderia se tornar o uso destas ferramentas.

Já na década de 1960 as ferramentas CAD passaram a ser utilizadas na criação
de aeronaves, automóveis e componentes eletrônicos. As empresas fabricantes criavam
seus próprios sistemas CAD. Mas isso demandava tempo e elevados custos. 

Um CAD primitivo chamado de Sketchpad surgiu no Instituto de Tecnologia de
Massachusetts,  criado  pelo  programador  Ivan  Sutherland.  O  usuário  desenhava  no
monitor com uma caneta, algo bastante moderno para a época.

Fonte: http://upload.wikimedia.org/wikipedia/en/7/7b/Sketchpad-Apple.jpg

Em 1977 a empresa francesa Dassault  Systèmes, liderada pelo engenheiro de
aeronaves Francis Bernard criou o CATIA (1977) e mais tarde o SolidWorks (1995) até
hoje um dos softwares mais utilizados na área de projetos. 

A empresa Autodesk surgiu em 1982 com a criação do Software AutoCAD 2D.
Era incialmente chamado de MicroCAD (COMDEX de 1982). Inicialmente, o software
foi escrito para vários sistemas operacionais, sobretudo para a arquitetura CP/M, mas
também para o MS DOS e Unix. O objetivo da companhia era usar a plataforma dos
PCs, lançados quase simultaneamente pela IBM, para tornar o AutoCAD conhecido e
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acessível aos usuários. Muitos fabricantes fizeram acordos de vendas mútuas, o que
contribuiu para a disseminação dos softwares de desenho pelo mundo.

http://virtualdimension.files.wordpress.com/2010/03/autocad_pc_at.jpg

Com o surgimento da empresa Apple, o Macintosh 128 passou a ser vendido já
com o MiniCAD instalado. 

http://www.sanedraw.com/LEARN/OVRV00_1/OV150/DRWINAFT.GIF

Na Figura abaixo se tem um projeto em formado DWG concebido na versão
2.18 do AutoCAD em 1985.  Como pode ser percebido, o usuário navegava com o
mouse pelo menu flutuante da direita e escolhia a ação que deveria ser desenvolvida. Se
clicassem em DRAW diversas opções eram abertas como LINE, CIRCLE, ARC entre
outras. Na parte de baixo da tela onde está escrito COMAND: é onde o usuário também
poderia escrever os comandos LINE.  A lógica de entrada de dados e como os comandos
funcionam mudou muito pouco nos últimos 30 anos. Se o usuário escrever LINE, por
exemplo, então ele precisa informar para o programa quais as coordenadas do primeiro
ponto e do segundo ponto. Se escrever ERASE então precisa selecionar qual a parte do
desenho que deverá ser apagado e assim por diante. 
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Com o  início  da  automatização,  na  década  de  90  as  empresas  de  CAD  se
desenvolveram como nunca. A disputa se dava entre Dassault Systèmes, a Parametric
Technology, a Unigraphics e a Autodesk. No ano de 1999 a Autodesk lançou o Software
Inventor.

Com  a  internet,  surgiram  os  softwares CAD  online  criados  pela  empresa
Dassault Systèmes. A Autodesk lançou sua primeira versão para a internet somente no
ano 2000. 

O AutoCAD 2D evoluiu muito e se tornou a principal plataforma de softwares
da Autodesk ao longo dos mais de 30 anos de história. O AutoCAD também ganhou
versões específicas para projetos de arquitetura, mecânica, infraestrutura, aplicações de
geoprocessamento,  entre  outras.  Até  o  seu  lançamento,  as  versões  existentes  eram
difíceis de usar e só funcionavam em computadores de grande porte. Pode se dizer que a
Autodesk popularizou o uso das ferramentas CAD. 

A partir da versão 12, a Autodesk abandonou o ambiente Unix, e desde a versão
14 descontinuou a versão para MS DOS, passando a trabalhar em cooperação com a
Microsoft, partilhando a sua tecnologia de base para aprimorar o sistema operacional
Windows, plataforma na qual o AutoCAD viria se consolidar.  O AutoCAD verão R14
era uma das versões mais amigáveis do programa. Os principais comandos eram bem
visíveis por meio das duas barras de ferramentas.
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Na Figura tem-se o AutoCAD 2002 com detalhes sobre a tela. 

Apesar de tantos avanços ainda é possível perceber que os ícones do AutoCAD 2016
mudaram muito pouco em relação à versão R14. 

 O AutoCAD, com seus formatos de arquivo DWG e DXF, se tornou padrão no
mercado de soluções genéricas de CAD, permitindo o intercâmbio com praticamente
todos os softwares CAD que surgiram posteriormente.

Atualmente os recursos em 3D permitem que usuários principiantes consigam
visualizar  objetos  em  qualquer  ângulo.  É  possível  visualizar  um  automóvel,  por
exemplo, e ver a parte de baixo, abrir suas portas, motor e obter uma riqueza de detalhes
de uma determinada peça em questão de segundos.
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Na versão AutoCAD  2015, por exemplo um desenho pode ser visualizado em
2D ou 3D a partir da escolha do modo de visualização: 

http://www.sdcpublications.com/pdfsample/978-1-58503-959-3-1.pdf

ANEXO IV – Desenhos ilustrativos realizados no AUTOCAD
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